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Overview 
 
FD9383-H(T)V is an indoor/outdoor fixed dome network camera capable of 5MP at 30 fps. 
With the VIVOTEK WDR Pro technology, the camera series is capable of capturing the 
highest quality images in both low light and high contrast environments. 
 
The onboard IR can provide illumination in total darkness. With the Smart IR feature, the 

avoid over-exposure. 

The cameras support WDR function at the effectiveness of up to 120dB. These models 
support local video storage on the MicroSD cards if network service should be interrupted. 

up to 5 privacy mask areas. 
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IMPORTANT: 

 

Revision History 

ƴ Rev. 1.0: Initial release. 
 

Read Before Use 
The use of surveillance devices may be prohibited by law in your country. The Network Camera is not only 
a high-performance web-ǊŜŀŘȅ ŎŀƳŜǊŀ ōǳǘ Ŏŀƴ ŀƭǎƻ ōŜ ǇŀǊǘ ƻŦ ŀ ŦƭŜȄƛōƭŜ ǎǳǊǾŜƛƭƭŀƴŎŜ ǎȅǎǘŜƳΦ Lǘ ƛǎ ǘƘŜ ǳǎŜǊΩs 
responsibility to ensure that the operation of such devices is legal before installing this unit for its intended 
use. 
It is important to first verify that all contents received are complete according to the Package Contents listed 
below. Take note of the warnings in the Quick Installation Guide before the Network Camera is installed; then 
carefully read and follow the instructions in the Installation chapter to avoid damage due to faulty assembly 
and installation. This also ensures the product is used properly as intended. 
The Network Camera is a network device and its use should be straightforward for those who have 
basic networking knowledge. It is designed for various applications including video sharing, general 
security/surveillance, etc. The Configuration chapter suggests ways to best utilize the Network Camera and 
ensure proper operations. For creative and professional developers, the URL Commands of the Network 
Camera section serves as a helpful reference to customizing existing homepages or integrating with the 
current web server. 
 
 
 
 

1. The product must be installed and protected in a location that is not easily accessible, 

and is away from impacts or heavy vibration. For example, at the location where the 

surveillance cameras are looking down or installed at high positions such as on a wall, 

or at least 3 meters above the ground. 

2. The camera should be installed at least 10 centimeters away from the eave of a building. 

3. If powered by a power adapter, the adapter should be properly grounded. 

4. Maintenance and repair work must always be carried out by qualified technical 

personnel. 

5. Disconnect power from the unit when performing a maintenance task. 

6. Please contact VIVOTEK's certified dealers for power adapters. 
 
 

 
 

ƴ ͮ Π ͖Ί͘ 

ƴ ͩ Ίͮ͞ Π ͘Ι Π ͖͎͔ͥ̓͟ 
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WARNING: 

IMPORTANT: 

 

1. IR lights emit from this product. 

2. Use appropriate shielding or eye protection. 
 

Symbols and Statements in this Document 
 INFORMATION: provides important messages or advice that might help 

prevent inconvenient or problem situations. 

 NOTE: Notices provide guidance or advice that is related to the functional 
integrity of the machine. 

 Tips: Tips are useful information that helps enhance or facilitate an 
installation, function, or process. 

 WARNING: or IMPORTANT:: These statements indicate 
situations that can be dangerous or hazardous to the machine or you. 

 Electrical Hazard: This statement appears when high voltage 
electrical hazards might occur to an operator. 

The camera is only to be connected to PoE networks without routing to outside plants. 

1. For PoE connection, use only UL listed I.T.E. with PoE output. 
 
1.  La caméra ne doit être raccordée quô¨ des réseaux PoE, sans routage vers des 

installations extérieures. 

2. Pour les raccordements PoE, utilisez uniquement un équipement de TI homologué UL, 

avec une sortie PoE. 

 
Use the camera only with a DC power supply that is UL listed, and limited power source 

(LPS) certified. The power supply should bear the UL listed and LPS marks. The power 

supply should also meet any safety and compliance requirements for the country of use. 

 
nôutilisez la caméra quôavec un bloc dôalimentation CC homologué UL, ainsi quôavec 

une alimentation limit®e (LPS) certifi®e. Le bloc dôalimentation doit porter les indications 

d'homologation UL et LPS. Il doit également répondre aux exigences en matière de 

s®curit® et de conformit® relatives au pays dôutilisation. 
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IMPORTANT: 

 

 

 
Camera Hardware Preventative Maintenance: 

1. Visual inspection of all major components including accessories, cabling and 

connections where accessible for signs of deterioration or damage. 

2. Check and clean cameras, lenses and housings inside and out as needed. 

Å Please do not scratch, damage, or leave fingerprints on the dome/front cover and/or 

lens because this may decrease image quality. 

Å For general cleaning of dirty areas, it is suggested to use compressed air to remove 

dust and/or other debris in order not to damage the on-board components. 

Å In order to clean oil stains, it is recommended to use a spray-type decomposing cleaner 

(absolutely avoid reciprocating wipes on the surface). After the oil has decomposed, 

spray it with water, dry with air, and/or absorb water with a cotton cloth or a soft cloth 

(dab, please avoid wiping). 

Å Do not use harsh detergents, gasoline, benzene or acetone, etc. to clean as they may 

deform or cause damage to the product. Also, excessive cleaning could damage the 

surface. 

3. Check images for correct field of view (pan, tilt and zoom focus) and adjust as 

necessary. 

4. Check and replace the Micro SD memory card as needed. 

Å Stop edge recording before removing the Micro SD memory card. 

Å Make sure that the Micro SD memory card is right side up and do not insert it with 

force, otherwise it may be damaged. 

Å When it is raining or the humidity is high, insertion or ejection of the Micro SD memory 

card is not recommended. 

5. Disassembly of the dome/front cover carries the risk of internal dew condensation, so 

please remember to replace the desiccant bags on the inside of the cameras before 

reassembly. 

6. Check that the camera view has not been blocked by obstacles and that you can see 

the property perimeter clearly. 

7. Make sure the interiors of cameras and accessories, like mounting kits and/or 

enclosures, are clean and dry. 

8. Make sure cameras are securely attached to the wall/ceiling/mounting kits. 
 
 

 

1. Please contact VIVOTEK's certified dealers for power adapters. 

2. Installation and maintenance service should only be performed by qualified technicians. 

3. If powered by a power adapter, the adapter should be properly grounded. 
 
 

NOTE: 
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For some customers who already have their own website or web control application, the 

Network Camera/Video Server can be easily integrated through URL syntax. This section 

specifies the external HTTP-based application programming interface. The HTTP-based 

camera interface provides the functionality to request a single image, control camera 

functions (PTZ, output relay, etc.), and get and set internal parameter values. The image 

and CGI requests are handled by the built-in Web server. 

 
Å To send URL commands in the address bar of your web browser, please remember to 

> Miscellaneous. 

 

Å For up-to-date documentation of URL commands, please go to VIVOTEKôs website, 

register an account with a business mail address and submit for authorization for SDK 

in Resources > Downloads > SDK. 
 

Å For any further technical support, please contact our technical support department. 
 

IMPORTANT: 
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IMPORTANT: 

 
Consumption & Power Input 

FD9383-H(T)V 

PoE 802.3af Class 0 - 42.5V/0.3A 12.95W, 57V/0.22A 12.95W (PoE midspan or endspan) 

DC 12V / 1.2A 
AC 24V~0.88A, 50-60Hz 

 
 
 
 
 
 
 

The equipment comes with an RTC battery. Note the following: 
 
Å Replacement of a battery with an incorrect type that can defeat a safeguard (for 

example, in the case of some lithium battery types); 

Å Disposal of a battery into a fire or a hot oven, or mechanically crushing or cutting of a 

battery, which can result in an explosion; 

Å Leaving a battery in an extremely high temperature surrounding environment that can 

result in an explosion or the leakage of flammable liquid or gas; and 

Å A battery subjected to extremely low air pressure that may result in an explosion or the 

leakage of flammable liquid or gas. 
 
Å CAUTION: Risk of fire or explosion if the battery is replaced by an incorrect type. 
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Hardware Installation 
For details on hardware installation, please refer to the Quick Installation Guide, available for download on 
Vivotek's website.  
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Shepherd 

 

Software Installation 

1. Please visit VIVOTEKôs website to Install the "Shepherdò software utility. The program 
will search for VIVOTEK Video Receivers, Video Servers or Network Cameras on the 
same LAN. 

Double-click on the cameraôs MAC address to open a web console to the camera. 
 

Browser 
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2. Install the Shepherd utility, which helps you locate and configure your network camera in the local 

network. Please Ǝƻ ǘƻ ±L±h¢9YΩǎ ǿŜōǎƛǘŜΣ ŀƴŘ ƭƻŎŀǘŜ ǘƘŜ ǳǘƛƭƛǘȅ ƛƴ ǘƘŜ wŜǎƻǳǊŎŜǎ Ҕ 5ƻǿƴƭƻŀŘǎ Ҕ  
Software page. 

 

3-1. Run the Shepherd utility. 
 
3-2. The program will conduct an analysis of your network environment. 
 



15 

 Network Camera  

Model No: FD9367-EHTV-v2 

MAC:0002D1730202  R o  HS 

 
 

 

 

  

IFBD83936607-W-EHTV-v2  192.168.4.151 00-02-D1-73-02-02 

 

3-3. The program will search for all VIVOTEK network devices on the same LAN. 
 
3-4. After a brief search, the installer window will prompt. Click on the MAC and model 

name that matches the one printed on the product label. You can then double-click on 
the address to open a management session with the Network Camera. 
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4. The first time you log in to the camera, the firmware will prompt for a password 

 
4-1 Since your camera is used for the first time, there is no password. Enter "root" as the 
username, and nothing for the password. 

 

 
4-2 Enter the combination of alphabetic and numeric characters to fulfill the password strength requirement. 
¢ƘŜ ŘŜŦŀǳƭǘ ƴŀƳŜ ŦƻǊ ǘƘŜ ŎŀƳŜǊŀ ŀŘƳƛƴƛǎǘǊŀǘƻǊ ƛǎ άǊƻƻǘέΣ and cannot be changed. 
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Some, but not all special ASCII characters are supported: !, %, -, ., @, ^, _, and ~. You 
can use them in the password combination. 

 

 
 
4-3. Another prompt will request the password you just configured. Enter the password, and then you can 
start configuring your camera and see the live view.
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1 

2 

 
5. On a web console, go to Configuration > Media > Image > Focus (IB9383-HTV only) to tune for the best 
image focus. 

Configuration > Media > Image > Focus 
 

 

Hardware Reset 

The reset button is used to reset the system or restore the factory default settings. 
Sometimes resetting the system can return the camera to normal operation. If the system 
problems remain after reset, restore the factory settings and install again. 
 
Reset: Press the recessed reset button. Wait for the Network Camera to reboot. 
 
Restore: Press and hold the reset button until the status LED rapidly blinks. Note that all 
settings will be restored to factory default. Upon successful restoration, the status LED will 
blink green and red during normal operation. 
 
 

SD/SDHC/SDXC Card Capacity 

This network camera is compliant with SD/SDHC/SDXC up to 1TB and other preceding 
standard SD cards. 
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802.3af PoE Switch 

 

 
PoE Power Injector 

(optional) 

Non-PoE Switch 

NOTE: 

 
Network Deployment 

General Connection (PoE) 

 When using a PoE-enabled switch 

The Network Camera is PoE-compliant, allowing transmission of power and data via a sin- 
gle Ethernet cable. Follow the below illustration to connect the Network Camera to a PoE- 
enabled switch via Ethernet cable. 

 

 
 
 

 When using a non -PoE switch  

Use a PoE power injector (optional) to connect between the Network Camera and a non- 

PoE switch. 
 

 
 
 

1. The camera is only to be connected to PoE networks without routing to outside plants. 

2. For PoE connection, use only UL listed I.T.E. with PoE output. 
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Ready to Use 

1. A browser session to the Network Camera should prompt as shown below. 

2. You should be able to see live video from your camera. You may also install the 
32-channel recording software in a deployment consisting of multiple cameras. For its 
installation details, please refer to its related documents. 
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Internet 

WAN (Wide Area Network )  

Router  IP  address  : from  ISP  

IP address : 192.168.0.3  

Subnet  mask : 255.255.255.0  

Default router : 192.168.0.1  

LAN (Local Area Network)  

Router  IP  address  : 192.168.0.1 

Cable or DSL Modem 

IP address : 192.168.0.2  

Subnet  mask : 255.255.255.0  

Default router : 192.168.0.1  

 
Internet connection via a router 

 
Before setting up the Network Camera over the Internet, make sure you have a router and follow 
the steps below. 

 
1. Connect your Network Camera behind a router, the Internet environment is illustrated below. 

Regarding how to obtain your IP address, please refer to Software Installation for details. 
 
 
 
 
 
 
 
 
 
 
 

 
 

2. In this case, if the Local Area Network (LAN) IP address of your Network Camera is 
192.168.0.3, please forward the following ports for the Network Camera on the router. 
 
ƴ HTTP port: default is 80 
ƴ RTSP port: default is 554 
ƴ RTP port for video: default is 5556 
ƴ RTCP port for video: default is 5557 

If you have changed the port numbers on the Network page, please open the ports 
accordingly on your router. For information on how to forward ports on the router, please refer 
to your routerôs userôs manual. 
 

3. Find out the public IP address of your router provided by your ISP (Internet Service Provider). 
Use the public IP and the secondary HTTP port to access the Network Camera from the 
Internet. Please refer to Network Type for details. 
 
 

Internet connection with static IP 
 

Choose this connection type if you are required to use a static IP for the Network Camera. 
Please refer to LAN setting for details. 

 
 

Internet connection via PPPoE (Point-to-Point over Ethernet) 
 

Choose this connection type if you are connected to the Internet via a DSL Line.  
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For example, your router and IP settings may look like this: 

Device IP Address: internal port IP Address: External Port (Mapped 
port on the router) 

Public IP of router 122.146.57.120  

LAN IP of router 192.168.2.1  

Camera 1 192.168.2.10:80 122.146.57.120:8000 

Camera 2 192.168.2.11:80 122.146.57.120:8001 

... ... ... 

 
Configure the router, virtual server, or firewall so that the router can forward any data coming 

into a preconfigured port number to a network camera on the private network and allow data 

from the camera to be transmitted to the outside of the network over the same path. 

From Forward to 

122.146.57.120:8000 192.168.2.10:80 

122.146.57.120:8001 192.168.2.11:80 

... ... 

 
When properly configured, you can access a camera behind the router using the HTTP 

request as follows: http://122.146.57.120:8000 

 
If you change the port numbers on the Network configuration page, please open the ports 

accordingly on your router. For example, you can open a management session with your 

router to configure access through the router to the camera within your local network. 

Please consult your network administrator for router configuration if you have troubles with 

the configuration. 

 
For more information with network configuration options (such as that of streaming ports), 

please refer to Configuration > Network Settings. VIVOTEK also provides the automatic 

port forwarding feature as an NAT traversal function with the precondition that your router 

must support the UPnP port forwarding feature. 
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Accessing the Network Camera 

This chapter explains how to access the Network Camera through web browsers, RTSP players, 
3GPP-compatible mobile devices, and VIVOTEK recording software. 

 

Using Web Browsers 

Use Installation Wizard 2 (IW2) to access the Network Cameras on LAN. 
If your network environment is not a LAN, follow these steps to access the Network Camera: 
1. Launch your web browser (e.g., Edge or Chrome). 
2. Enter the IP address of the Network Camera in the address field. Press Enter. 
3. Live video will be displayed in your web browser. 
4.  If it is the first time installing the VIVOTEK network camera, an information bar will prompt. 

Follow the instructions to install the required plug-in on your computer. 
 

Ʒ By default, the Network Camera is not password-protected. To prevent unauthorized 
access, it is highly recommended to set a password for the Network Camera. 
For more information about how to enable password protection, please refer to Security. 
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pvPlayer 

 
Using RTSP Players 

To view the streaming media using RTSP players, you can use one of the following players that 
support RTSP streaming. 

 VLC media player 

1. Launch the RTSP player. 

2. Choose File > Open URL. A URL dialog box will pop up. 

3. The address format is rtsp://<ip address>:<rtsp port>/<RTSP streaming access name for 
stream1 or stream2> 

As most ISPs and players only allow RTSP streaming through port number 554, please set the 
RTSP port to 554. For more information, please refer to RTSP Streaming. 
For example: 

 
 
 
 
 
 

4. The live video will be displayed in your player. 
For more information on how to configure the RTSP access name, please refer to RTSP 
Streaming for details. 
 

 
 
 
 

 

rtsp://192.168.5.151:554/live1s1.sdp  
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Using 3GPP-compatible Mobile Devices 

To view the streaming media through 3GPP-compatible mobile devices, make sure the Network 
Camera can be accessed over the Internet. For more information on how to set up the Network 
Camera over the Internet, please refer to Setup the Network Camera over the Internet. 

 
To utilize this feature, please check the following settings on your Network Camera: 

 
1.  Because most players on 3GPP mobile phones do not support RTSP authentication, make 

sure the authentication mode of RTSP streaming is set to disable. 
For more information, please refer to RTSP Streaming. 
 

2.  As the the bandwidth on 3G networks is limited, you will not be able to use a large video size. 
Please set the video streaming parameters as listed below. 
For more information, please refer to Stream settings. 
 
Video Mode H.264 

Frame size 176 x 144 

Maximum frame rate 5 fps 

Intra frame period 1S 

Video quality (Constant bit rate) 40kbps 

 
 

3.  As most ISPs and players only allow RTSP streaming through port number 554, please set 
the RTSP port to 554. For more information, please refer to RTSP Streaming. 
 

4. Launch the player on the 3GPP-compatible mobile devices (e.g., VLC player). 
 

5. Type the following URL commands into the player. 
The address format is rtsp://<public ip address of your camera>:<rtsp port>/<RTSP streaming 
access name for stream # with small frame size and frame rate>. 
For example: 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can configure Stream #2 into the suggested stream settings as listed above for live 
viewing on a mobile device. 
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Tips: 

 
Using VIVOTEK Recording Software 

Visit our website for download the VAST or VSS recording software that provides simultaneous 
monitoring and video recording for multiple Network Cameras. Please install the recording 
software; then launch the program to add the Network Camera to the Channel list. For detailed 
information about how to use the recording software, please refer to the userôs manual of the 
software or download it from http://www.vivotek.com. 

 

 
 

1.  If you encounter problems with displaying live view or the onscreen plug-in control, you may try 

to remove the plug-ins that might have been installed on your computer. Remove the following 

folder: C:\Program Files (x86)\Camera Stream Controller\. 

 
2.  If you forget the root (administrator) password for the camera, you can restore the camera 

defaults by pressing the reset button for longer than 5 seconds. 

 
3.  If DHCP is enabled in your network, and the camera cannot be accessed, run the Shepherd 

utility to search the network. If the camera has been configured with fixed IP that does not 

comply with your local network, you may see its default IP 169.254.x.x. If you still cannot find 

the camera, you can restore the camera to its factory defaults. 

 
4.  If you change your network parameters, e.g., added a connection to a LAN card, re-start the 

Shepherd utility. 
 

http://www.vivotek.com/
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Manual Trigger 

Main Page 

This chapter explains the layout of the main page. It is composed of the following sections: 
VIVOTEK INC. Logo, Host Name, Camera Control Area, Configuration Area, Menu, and Live 
Video Window. 

 
 

VIVOTEK INC. 

Logo 

Resize Buttons 
 

 

 

 
Host Name 

 

 
 

Configuration 

Area 

 
Camera Control 

Area 

 
 
 
 

Hide Button 

Live View Window 

 
 
 
 
 
 
 
 

VIVOTEK INC. Logo 
Click this logo to visit the VIVOTEK website. 
 

Host Name 

cameras in your surveillance deployment. For more information, please refer to System. 
 

Camera Control Area 
 
Profile mode: 4 pre-configured streaming profiles are provided through here: Max. view, Recording 

 
 

> Media > . 
 

If you want to hide this item on the homepage, please go to Configuration> System > Homepage 
Layout > General settings > Customized button to deselect the ñshow manual trigger buttonò 
checkbox. 

FD9383-HTV 
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Configuration Area 

Client Settings: Click this button to access the client setting page. For more information, please refer to Client 
Settings. 
Configuration: Click this button to access the configuration page of the Network Camera. It is suggested that 
a password be applied to the Network Camera so that only the administrator can configure the Network 
Camera. For more information, please refer to Configuration. 
Language: Click this button to choose a language for the user interface. Language options are available in: 

English, Deutsch, Español, Français, Italiano, ѡӐ , Português, Мѝ, and Мѝ.   

 
Hide Button 

You can click the hide button to hide or display the control panel. 
 

Resize Buttons 

 : 

Click the Auto button, the video cell will resize automatically to fit  the monitor. Click 100% is to display the 
original homepage size. 
Click 50% is to resize the homepage to 50% of its original size. Click 25% is to resize the homepage to 25% of 
its original size. 
 

Live Video Window 

ƴ The following window is displayed when the video mode is set to H.264 or H.265: 
H.265/264 Protocol and Media Options 

 

Video Title 

Title and Time 

Zoom Indicator 

 
Video (TPC-AV) 

Video 17:08:56 2018/03/25 

 
x4.0 

Time 

 

 
 
 
 
 
 
 
 

Video Control Buttons 

Video Title: The video title can be configured. For more information, please refer to Video Settings. 
H.264 or H. 265 Protocol and Media Options: The transmission protocol and media options for H.264 or 
H.265 video streaming. For further configuration, please refer to Client Settings. 
Time: Display the current time. For further configuration, please refer to Media > Image > Genral settings. 
Title and Time: The video title and time can be stamped on the streaming video. For further configuration, 
please refer to Media > Image > General settings. 

2018/03/25 17:08:56 
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PTZ PanelΥ ¢Ƙƛǎ bŜǘǿƻǊƪ /ŀƳŜǊŀ ǎǳǇǇƻǊǘǎ άŘƛƎƛǘŀƭά όŜ-PTZ) pan/tilt/zoom control, which allows roaming a 
smaller view frame within a large view frame. Please refer to PTZ settiings for detailed information. 
Global View: Click on this item to display the Global View window. The Global View window contains a full 
view image (the largest frame size of the captured video) and a floating frame (the viewing region of the 
current video stream). The floating frame allows users to control the e-PTZ function (Electronic Pan/ 
Tilt/Zoom). For more information about e-PTZ operation, please refer to E-PTZ Operation.  

The viewing region of 
the current video stream 

 
The largest frame size 

 
 
 
 
 
 
Note that the PTZ buttons on the panel are not operational unless you are showing only a portion of the full 
image. If the live view window is displaying the full view, the PTZ buttons are not functional. 
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Video Control Buttons: Depending on the Network Camera model and Network Camera configuration, 
some buttons may not be available. 

 Snapshot: Click this button to capture and save still images. The captured images will be displayed in a 
pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP (*.bmp) 
format. 

 Digital Zoom: Click and uncheck ά5ƛǎŀōƭŜ digital ȊƻƻƳέ to enable the zoom operation. The navigation 
screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To 
move to a different area you want to magnify, drag the navigation screen. 
 

 Pause: Pause the transmission of the streaming media. The button becomes the  Resume button after 
clicking the Pause button. 

 Stop: Stop the transmission of the streaming media. Click the  Resume button to continue 
transmission. 
 

 Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer. Press 

the  Stop MP4 Recording button to end recording. When you exit the web browser, video recording stops 
accordingly. To specify the storage destination and file name, please refer to MP4 Saving Options for details. 
 

 Full Screen: Click this button to switch to full screen mode. Press the ά9ǎŎέ key to switch back to normal 
mode. 
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ƴ The following window is displayed when the video mode is set to MJPEG: 
 

Video Title 

Title and Time 

Time 

 

 
 
 
 
 
 
 
 
 
 

Video Control Buttons 

 
Video Title: The video title can be configured. For more information, please refer to Media > Image. 
Time: Display the current time. For more information, please refer to Media > Image. 
Title and Time: Video title and time can be stamped on the streaming video. For more information, please 
refer to Media > Image. 
Video Control Buttons: Depending on the Network Camera model and Network Camera configuration, 
some buttons may not be available. 

 Snapshot: Click this button to capture and save still images. The captured images will be displayed in a 
pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP (*.bmp) 
format. 

 Digital Zoom: Click and uncheck ά5ƛǎŀōƭŜ digital ȊƻƻƳέ to enable the zoom operation. The navigation 
screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To 
move to a different area you want to magnify, drag the navigation screen. 
 

 Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer. Press 

the  Stop MP4 Recording button to end recording. When you exit the web browser, video recording stops 
accordingly. To specify the storage destination and file name, please refer to MP4 Saving Options for details. 

 Full Screen: Click this button to switch to full screen mode. Press the ά9ǎŎέ key to switch back to normal 
mode. 

 

 2018/07/25 17:08:56 
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H.264 Protocol Options 

Client Settings 

This chapter explains how to select the stream transmission mode and saving options on the 
local computer. When completed with the settings on this page, click Save on the page bottom 
to enable the settings. 

 
 
 

H.265/H.264 Protocol Options 
 

 
 
Depending on your network environment, there are four transmission modes of H.264 streaming: 
UDP unicast: This protocol allows for more real-time audio and video streams. However, network packets 
may be lost due to network burst traffic and images may be broken. Activate UDP connection when 
occasions require time-sensitive responses and the video quality is less important. Note that each unicast 
client connecting to the server takes up additional bandwidth and the Network Camera allows up to ten 
simultaneous accesses. 
UDP multicast: This protocol allows multicast-enabled routers to forward network packets to all clients 
requesting streaming media. This helps to reduce the network transmission load of the Network Camera 
while serving multiple clients at the same time. Note that to utilize this feature, the Network Camera must be 
configured to enable multicast streaming at the same time. For more information, please refer to RTSP 
Streaming. 
TCP: This protocol guarantees the complete delivery of streaming data and thus provides better video quality. 
The downside of this protocol is that its real-time effect is not as good as that of the UDP protocol. 
HTTP: This protocol allows the same quality as TCP protocol without needing to open specific ports for 
streaming under some network environments. Users inside a firewall can utilize this protocol to allow 
streaming data through. 
 
 
 

Two way audio 
 

 
 
 
 
Half duplex: Audio is transmitted from one direction at a time, e.g., from a PC holding a web console with 
the camera. 
Full duplex: Audio is transmitted in both directions simultaneously. 
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MP4 Saving Options 

 

 

Users can record live video as they are watching it by clicking  Start MP4 Recording on the main 
page. Here, you can specify the storage destination and file name. 
Folder: Specify a storage destination on your PC for the recorded video files. The location can be 
changed. 
File name prefix: Enter the text that will be appended to the front of the video file name. A specified folder 
will be automatically created on your local hard disk. 
Add date and time suffix to the file name: Select this option to append the date and time to the end of the 
file name. 

 
 

Local Streaming Buffer Time 
 

In the case of encountering unsteady bandwidth, live streaming may lag and video streaming may not be 
ǾŜǊȅ ǎƳƻƻǘƘƭȅΦ LŦ ȅƻǳ ŜƴŀōƭŜ ǘƘƛǎ ƻǇǘƛƻƴΣ ǘƘŜ ƭƛǾŜ ǎǘǊŜŀƳƛƴƎ ǿƛƭƭ ōŜ ǎǘƻǊŜŘ ǘŜƳǇƻǊŀǊƛƭȅ ƻƴ ȅƻǳǊ t/Ωǎ cache 
memory for a few milli seconds before being played on the live viewing window. This will help you see the 
streaming more smoothly. If you enter 3,000 Millisecond, the streaming will delay for 3 seconds. 

CLIP_20190321-180853 

File name  preþxDate  and  time  sufþx 

The format  is: YYYYMMDD_HHMMSS 



34 

NOTE: 

 
Joystick settings 
 
Enable Joystick 
Connect a joystick to a USB port on your management computer. Supported by the plug-ƛƴ όaƛŎǊƻǎƻŦǘΩǎ 
DirectX), once the plug-in for the web console is loaded, it will automatically detect if there is any joystick on 
the computer. The joystick should work properly without installing any other driver or software. 
Then you can begin to configure the joystick settings of connected devices. Please follow the 
instructions below to enable joystick settings. 

1.  Select a detected joystick, if there are multiple, from the Selected joystick menu. If your joystick 
is not detected, if may be defective. 

2. Click Calibrate or Configure buttons to configure the joystick-related settings. 
 

 

Å If you want to assign Preset actions to your joystick, the preset locations should be configured 
in advance in the Configuration > PTZ page. In Windows, use the search function on the Start 
menu to search for Game Controller. 

Å If your joystick is not working properly, it may need to be calibrated. Click the Calibrate button 
to open the Game Controllers window located in Microsoft Windows control panel and follow the 
instructions for trouble shooting. 

Å The joystick will appear in the Game Controllers list in the Windows Control panel. If you want to 

check out for your devices, go to the following page: Start -> Control Panel -> Game Controllers. 
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Buttons Configuration 
In the Button Configuration window, the left column shows the actions you can assign, and the right column 
shows the functional buttons and assigned actions. The number of buttons may differ from different joysticks. 
Please follow the steps below to configure your joystick buttons: 

1.  Choosing one of the actions and click Assign will pop up a dialog. Then you can assign this 

action to a button by pressing the joystick button or select it from the drop-down list. 

For example: Assign Home (move to home position) to Button 1. 

2. Click OK to confirm the configuration. 
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Tips: 

 
Buttons Configuration 
Click the Configure Buttons button, a window will prompt as shown below. Please follow the steps 
below to configure your joystick buttons: 
1. Select a button number from the Button # pull-down menu. 
 

If you are not sure of the locations of each 
button, use the Properties window in the Game 
Controllers utility. 

 

 
 

 
 
 
2. Select a corresponding action, such as Patrol or Preset#. 

3.  Click the Assign button to assign an action to 
the button. You can delete an association by 
selecting a button number, and then click the 
Delete button. 

Repeat the process until you are done with the 
configuration of all preferred actions. 
The buttons you define should appear on the button list 
accordingly. 
 
4.  Please remember to click the Save button 

on the Client settings page to preserver your 
settings. 
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Configuration 

Click Configuration on the main page to enter the camera setting pages. Note that only 
Administrators can access the configuration page. 

 
VIVOTEK provides an easy-to-use user interface that helps you set up your network camera 
with minimal effort. In order to simplify the user interface, detailed information will be hidden 
unless you click on the function item. When you click on the first sub-item, the detailed 
information for the first sub-item will be displayed; when you click on the second sub-item, the 
detailed information for the second sub-item will be displayed and that of the first sub-item will 
be hidden. 

 
The following is the interface of the main page: 

 
 
Each function on the configuration list will be explained in the following sections. 
 
The Navigation Area provides access to all different views from the Home page (for live viewing), 

Configuration page, and multi-language selection. 
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System > General settings 

This section explains how to configure the basic settings for the Network Camera, such as the 
host name and system time. It is composed of the following two columns: System, and System 
Time. When finished with the settings on this page, click Save at the bottom of the page to 
enable the settings. 

 
System 

 

 
Host name: Enter a desired name for the Network Camera. The text will be displayed at the top of the 
main page, and also on the view cells of the ST7501 and VAST management software. 
Turn of f the LED indicators: If you do not want others to notice the network camera is in operation, you can 
select this option to turn off the LED indicators. 
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System time 

 

 
Enable daylight saving time: Turn on to better use of the longer daylight during the summer. 
Keep current date and time: Select this option to preserve the current date and time of the Network Camera. 
¢ƘŜ bŜǘǿƻǊƪ /ŀƳŜǊŀΩǎ ƛƴǘŜǊƴŀƭ ǊŜŀƭ-time clock maintains the date and time even when the power of the 
system is turned off. 
Synchronize with computer time: Select this option to synchronize the date and time of the Network 
Camera with the local computer. The read-only date and time of the PC is displayed as updated. 
Manual: The administrator can enter the date and time manually. Note that the date and time format are 
[yyyy/mm/dd] and [hh:mm:ss]. 
Synchronize with NTP server: Assign the IP address or domain name of the time-server. Leaving the text box 
blank connects the Network Camera to the default time servers. The precondition is that the camera must 
have the access to the Internet. 
Update interval: Select to update the time using the NTP server on an hourly, daily, weekly, or monthly 
basis. 
 

Time zone : Select the appropriate time zone from the list. You can scroll down on the Time zone menu to 

find the Customize option and use the POSIX TZ variables. For example, http://www.gnu.org/software/ 
libc/manual/html_node/TZ-Variable.html. 

 

Here are some examples for TZ values, including the appropriate Daylight Saving Time and its 

dates of applicability. In North American Eastern Standard Time (EST) and Eastern Daylight 

Time (EDT), the normal offset from UTC is 5 hours; since this is west of the prime meridian, 

the sign is positive. Summer time begins on Marchôs second Sunday at 2:00am, and ends on 

Novemberôs first Sunday at 2:00am. EST+5EDT,M3.2.0/2,M11.1.0/2 

 

http://www.gnu.org/software/
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Israel Standard Time (IST) and Israel Daylight Time (IDT) are 2 hours ahead of the prime 

meridian in winter, springing forward an hour on Marchôs fourth Thursday (i.e., on the first Friday 

on or after March 23), and falling back on Octoberôs last Sunday. 

IST-2IDT,M3.4.4,M10.5.0 
 

Western Argentina Summer Time (WARST) is 3 hours behind the prime meridian all year. There is a dummy 
fall-back transition on December 31 at 25:00 daylight saving time (i.e., 24:00 standard time, equivalent to 
January 1 at 00:00 standard time), and a simultaneous spring-forward transition on January 1 at 00:00 
standard time, so daylight saving time is in effect all year and the initial WART is a placeholder. 
 
The format is TZ = local_timezone,date/time,date/time. 

Here, date is in the Mm.n.d format, where: 

Mm (1-12) for 12 months 

n (1-5) 1 for the first week and 5 for the last week in the month 

d (0-6) 0 for Sunday and 6 for Saturday 
 
CST6CDT is the name of the time zone 

CST is the abbreviation used when DST is off 

6 hours is the time difference from GMT 

CDT is the abbreviation used when DST is on 

,M3 is the third month 

.2 is the second occurrence of the day in the month 

.0 is Sunday 

/2 is the time 

,M11 is the eleventh month 

.1 is the first occurrence of the day in the month 

.0 is Sunday 

/2 is the time 
 
The minimum specifier is down to the hour. 
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System > Homepage layout 

This section explains how to set up your own customized homepage layout. 
 

General settings 
This column shows the settings of your homepage layout. You can manually select the background in this 
preview field. The following shows the homepage using the default settings and font colors in Theme 
Options (the second tab on this page). The settings will be displayed automatically. 

 
ƴ Hide Powered by VIVOTEK: If you check this item, it will be removed from the homepage. 

 
Logo graph 
Here you can change the logo that is placed at the top of your homepage. 
 

Follow the steps below to upload a new logo: 
1. Click Custom and the Browse field will appear. 
2. Select a logo from your files. 
3. Click Upload to replace the existing logo with a new on. 
4. Enter a website link if necessary. 
5. Click Save to enable the settings. 
 
Customized button 
If you want to hide manual trigger buttons on the homepage, please uncheck this item. This item is checked 
by default. 
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 FD9383-HTV  

FD9383-HTV 

 
Theme Options 

Here you can change the color of your homepage layout. There are three types of preset patterns for you to 
choose from. The new layout will simultaneously appear in the Preview  Save to enable the 
settings. 
 
 
 
 
 

Font Color 

Background Color of the 

Control Area 

Font Color of 

the Configuration Area 

Background Color of the 

Configuration Area 

 FD9383-HTV  
  Font Color of the 

Video Title 

 
 
 
 
 

Background Color of 

the Video Area 

Frame Color 
 

 
 
 

Preset patterns 
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2 

1 3 

4 

 
ƴ Follow the steps below to set up the customized homepage: 
1. Click Custom on the left column. 
2. Click the field where you want to change the color on the right column. 

 
 
 
Color Selector 
 
 
 
 
 
Custom Pattern 
 

3. The palette window will pop up as shown below. 
 

4. Drag the slider bar and click on the left square to select a desired color. 
5. The selected color will be displayed in the corresponding fields and in the Preview column. 
6. Click Save to enable the settings. 
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System > Logs 

This section explains how to configure the Network Camera to send the system log to a remote 
server as backup. 

 
Log server settings 

 

Follow the steps below to set up the remote log: 

1. Select Enable remote log. 
2. In the IP address text box, enter the IP address of the remote server. 
2. In the port text box, enter the port number of the remote server. 
3. When completed, click Save to enable the setting. 

You can configure the Network Camera to send the system log file to a remote server as a log backup. Before 
utilizing this feature, it is suggested that the user install a log-recording tool to receive system log messages 
from the Network Camera. An example is Kiwi Syslog Daemon. Visit http://www.kiwisyslog. com/kiwi-syslog-
daemon-overview/. 
 

System log 
 

This column displays the system log in a chronological order. The system log is stored in the Network 
/ŀƳŜǊŀΩǎ buffer area and will be overwritten when reaching a certain limit. 
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You can install the included VAST recording software, which provides an Event 
Management function group for delivering event messages via emails, GSM short 
messages, onscreen event panel, or to trigger an alarm, etc. For more information, refer to 
the VAST User Manual. 
 

 
 

Smartphone 

HTTP  

VIVOCloud 

 

Cell phone 

Short message 

GSM 

Modem 
Server with 

VAST Recording Software 
 

 

Email 
 
 
 
 

FTP 

 
 

Deterrent  
Digital output 

 
PTZ 

 
Internet 
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Access log 
 

Access log displays the access time and IP address of all viewers (including operators and administrators) in a 
ŎƘǊƻƴƻƭƻƎƛŎŀƭ ƻǊŘŜǊΦ ¢ƘŜ ŀŎŎŜǎǎ ƭƻƎ ƛǎ ǎǘƻǊŜŘ ƛƴ ǘƘŜ bŜǘǿƻǊƪ /ŀƳŜǊŀΩǎ ōǳŦŦŜǊ ŀǊŜŀ ŀƴŘ ǿƛƭƭ ōe overwritten 
when reaching a certain limit. 
 
 
Set Parameter log 
VADP log contains the history of changes made to system parameters such as recording, imaging parameters, 
and all other parameters. 
 
 
 
VADP log 
VADP log contains the information for the onboard VADP packages, including memory usage, module 
load and unload information. 
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System > Audit Log 

This section shows the login (no matter if successful) record of all users. 
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System > Parameters 

The View Parameters page lists the entire systemôs parameters. If you need technical 
assistance, please provide the information listed on this page. 
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Reboot  system now!!  

This connection  will close.  

Starting  firmware  upgrade...  

Do not  power  down  the  server during  the  upgrade. 

The server will restart automatically after the upgrade is 

completed.  

This will take about 1 - 5 minutes. 

Wrong PKG file format  

Unpack  fail  

 
System > Maintenance 

This chapter explains how to restore the Network Camera to factory default, upgrade firmware 
version, etc. 

 
General settings > Upgrade firmware 

 

 
This feature allows you to upgrade the firmware of your Network Camera. It takes a few minutes to complete 
the process. 

Note: Do not power off the Network Camera during the upgrade! 

Follow the steps below to upgrade the firmware: 
1. Download the latest firmware file from the VIVOTEK website. The file is in .pkg file format. 
2. Click Browseé and locate the firmware file. 
3. Click Upgrade. The Network Camera starts to upgrade and will reboot automatically when the upgrade 

completes. 

 
If the upgrade is successful, you will see άwŜōƻƻǘ system now!! This connection will ŎƭƻǎŜέΦ After that, re- 
access the Network Camera. 
 
The following message is displayed when the upgrade has succeeded. 
 

The following message is displayed when you have selected an incorrect firmware file. 
 

General settings > Reboot 
 

This feature allows you to reboot the Network Camera, which takes about one minute to complete. When 
completed, the live video page will be displayed in your browser. The following message will be displayed 
during the reboot process. 
 
 
 
 
If the connection fails after rebooting, manually enter the IP address of the Network Camera in the 
address field to resume the connection. 
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General settings > Restore 

 

This feature allows you to restore the Network Camera to factory default settings. 
Network: Select this option to retain the Network Type settings (please refer to Network Type). 
Daylight Saving Time: Select this option to retain the Daylight Saving Time settings (please refer to 
Import/Export files below on this page). 
Custom Language: Select this option to retain the Custom Language settings. 
VADP: Retain the VADP modules (3rd-party software stored on the SD card) and related settings. 
Focus position: Retain the lens focus position using the previously saved position parameters. 
If none of the options is selected, all settings will be restored to factory default. The following message is 
displayed during the restoring process. 
 

 
Import/Export files 

 
This feature allows you to Export /  Update custom language file, configuration file, and server status 
report. 
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Tips: 

 
 
 
Export language file: Click to export language strings. VIVOTEK provides nine languages: English, Deutsch, 

Español, Français, Italiano, ѡӐ , Português, , and Мѝ. 

Update custom language file: Click .ǊƻǿǎŜΧ and specify your own custom language file to upload. Export 
configuration file: Click to export all parameters for the device and user-defined scripts. 
Update configuration file: Click .ǊƻǿǎŜΧ to update a configuration file. Please note that the model and 
firmware version of the device should be the same as the configuration file. If you have set up a fixed IP or 
other special settings for your device, it is not suggested to update a configuration file. 
 
Export server staus report: Click to export the current server status report, such as time, logs, parameters, 
process status, memory status, file system status, network status, kernel message ... and so on. 
 
 
 
 
 

Å If a firmware upgrade is accidentally disrupted, say, by a power outage, you still have a last resort 

method to restore normal operation. See the following for how to bring the camera back to work: 
Applicable scenario: 

(a) Power disconnected during firmware upgrade. 
(b) Unknown reason causing abnormal LED status, and a Restore cannot recover normal working 

condition. 

You can use the following methods to activate the camera with its backup firmware: 

(a) Press and hold down the reset button for at least one minute. 
(b) Power on the camera until the Red LED blinks rapidly. 
(c) After boot up, the firmware should return to the previous version before the camera hanged. (The 

procedure should take 5 to 10 minutes, longer than the normal boot-up process). When this 
process is completed, the LED status should return to normal. 
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Media > Image 

This section explains how to configure the image settings of the Network Camera. It is 
composed of the following columns: General settings, IR control, Image settings, Exposure, 
Focus, and Privacy mask. The Focus window is available only for models that come with 
motorized lens. 
 

 
General settings 
 
 
Color: Select to display color or black/white video streams. 
Power line frequency: Set the power line frequency consistent with local utility settings to eliminate image 
flickering associated with fluorescent lights. Note that after the power line frequency is changed, you must 
disconnect and reconnect the power cord of the Network Camera in order for the new setting to take effect. 
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Video orientation: Flip - vertically reflect the display of the live video; Mirror - horizontally reflect the display 
of the live video. Select both options if the Network Camera is installed upside-down (e.g., on the ceiling) to 
correct the image orientation. Please note that if you have preset locations, those locations will be cleared 
after flip/mirror setting. 
 
 
Rotate - 
 

 
 
The rotation here indicates clockwise  
rotation. Rotation can be applied with  
flip, mirror, and physical lens rotation  
(see below) settings to adapt to different  
mounting locations. 
The figures in the illustration are shown  
In a consecutive order. 
 
 

 
 
The camera may be installed on a vertical, side-facing, or tilted surface in order to accommodate the interior 
or exterior design of a building. The interior of a building can be shaped as a narrow rectangular space, such 
as a corridor. The conventional HD image, such as that of a 16:9 aspect ratio, will be incongruous with its 
wide horizontal view. With video rotation, the camera can more readily cover the field of view on a tall and 
narrow scene. 
 
 

Day/Night Settings 
 
 
Switch to B/W in night mode 
Select this to enable the Network Camera to automatically switch to Black/White during night mode. 

Normal Flip Mirror  Rotate 90° 

 clockwise 
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IR cut filter 
With a removable IR-cut filter, this Network Camera can automatically remove the filter to let Infrared 
light pass into the sensor during low light conditions. 

ƴ Auto mode (The Day/Night Exposure Profile will not be available if Auto mode is selected) 

The Network Camera automatically removes the filter by judging the level of ambient light. 

ƴ Day mode 

In day mode, the Network Camera switches on the IR cut filter at all times to block infrared light 
from reaching the sensor so that the colors will not be distorted. 

ƴ Night mode 

In night mode, the Network Camera switches off the IR cut filter at all times for the sensor to 
accept infrared light, thus helping to improve low light sensitivity. 

ƴ Synchronize with digital input 

If an external IR device is connected that comes with its own light sensor, you can use a digital input from it 
to trigger the IR cut filter. Doing so can synchronize the detection of light level between the camera and the 
external IR device. 
 
ƴ Schedule mode 

The Network Camera switches between day mode and night mode based on a specified schedule. Enter the 
start and end time for day mode. Note that the time format is [hh:mm] and is expressed in 24-hour clock 
time. By default, the start and end time of day mode are set to 07:00 and 18:00. 
Sensitivity of IR cut filter 
Tune the responsiveness of the IR filter to lighting conditions as Low, Normal, or High. 
 
When completed with the settings on this page, click Save to enable the settings. 
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Overlay settings 
Decide if and how to display timestamps and customized text in different video streams. 
Position of timestamp and video title on image: Select to display time stamp and video title on the 

top or at the bottom of the video stream. 
Timestamp and video title font size: Select the font size for the time stamp and title. 
 

 
 
Illuminators 
 
Turn on built-in IR illuminator in night mode 
Select this to turn on the ŎŀƳŜǊŀΩǎ onboard IR illuminator when the camera detects low light condition 
and enters the night mode. 
 
Turn on external IR illuminator in night mode 
Select which DO (digital output) you use to trigger an external IR illuminator. 
 
 
Anti-overexposure 
When enabled, the camera automatically adjusts the IR projection to adjacent objects in order to avoid over-
exposure in the night mode. 
Smart IR 
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Bright object: When enabled, the camera automatically adjusts the IR projection to adjacent objects 
in order to avoid over-exposure in the night mode. 
Object of interest: This requires you to configure on the Smart VCA. Please open the Smart VCA 
feature on the Application panel. 
The Smart IR function is more beneficial when the spot of intrusions or an object of your interest is close 
to the lens and the IR lights. For example, if an intruder has a chance of getting near the range of 3 meters, 
Smart IR can effectively reduce the over-exposure. For a surveillance area at a greater distance, e.g., 5 
meters or farther away, the Smart IR function may not bring as significant benefits as in close range. 
 

Smart IR disabled; distance: 5M Smart IR enabled; distance: 5M 
 

 
Smart IR disabled; distance: 3M Smart IR enabled; distance: 3M 
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 Exclude 

 

 

 
 

 

 
If there is an object in close proximity, the IR lights 
reflected back from it can mislead the Smart IRôs 
calculation of light level. To solve this problem, you 
can place an ñExposure Excludeò window on an 
unavoidable object in the Exposure setting window.  

You can also configure the ñExposure Excludeò 
window in a night mode ñProfileò setting so that your 
day time setting is not affected. 

 Exclude 

Tips: 
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Image settings 
On this page, you can tune the White balance and Image adjustment. 
 
 
 
 
 
 
 
 
 
 
 
Sensor Setting 2: 
For special situations 
Sensor Setting 1: 
For normal situations 
 
 
 
 
 
 
 
 
 
White balance: Adjust the value for the best color temperature. 
ƴ You may follow the steps below to adjust the white balance to the best color temperature. 

1. Place a sheet of paper of white or cooler-color temperature color, such as blue, in front of the 
lens, then allow the Network Camera to automatically adjust the color temperature. 

2. Click the On button to Fix current value and confirm the setting while the white balance is being 

measured. 

ƴ You may also manually tune the color temperature by pulling the RGain and BGain slide bars. 

Image Adjustment 
ƴ Brightness: Adjust the image brightness level, which ranges from 0% to 100%. 

ƴ Contrast: Adjust the image contrast level, which ranges from 0% to 100%. 

ƴ Saturation: Adjust the image saturation level, which ranges from 0% to 100%. 

ƴ Sharpness: Adjust the image sharpness level, which ranges from 0% to 100%. 

ƴ Gamma curve: Adjust the image sharpness level, which ranges from 0.45 to 1, from Detailed to 
Contrast. You may let firmware Optimize your display or select the Manual mode, and pull the 
slide bar pointer to change the preferred level of Gamma correction towards higher contrast or 
towards the higher luminance for detailed expression for both dark and lighted areas of an image. 

This option is disabled when the WDR feature is enabled. 
Defog: Defog helps improve the visibility quality of captured image in poor weather conditions such 
as smog, fog, or smoke. 
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Noise reduction 
ƴ Enable noise reduction: Check to enable noise reduction in order to reduce noises and flickers 

in image. This applies to the onboard 3D Noise Reduction feature. Use the slide bar to adjust 
the reduction strength. Note that applying this function to the video channel will consume system 
computing power. 

3D Noise Reduction is mostly applied in low-light conditions. When enabled in a low-light condition with fast 
moving objects, trails of after-images may occur. You may then select a lower strength level or disable the 
function. 
 
Lens distortion detection 
ƴ Strong light sources will be masked from the scene, and the image contrast will be strengthened. 

This function is useful to prevent the spot-light effects in a high dynamic scene. 
False color may be observed around the edges of strong light sources. 
Enable digital image stabilizer 
If you experience problems such as vibration on a pole mount, try enable the image stabilizer. 
In H 

Note that the Preview button has been cancelled, all changes made to image settings is directly a shown on 
screen. You can click Restore to recall the original settings without incorporating the 
changes. When completed with the settings on this page, click Save to enable the setting. You can also 
click on Profile mode to adjust all settings above in a tabbed window for special lighting conditions. 

 
Enable to apply these settings at: Select the mode this profile to apply to: Day mode, Night mode, or 
Schedule mode. Please manually enter a range of time if you choose the Schedule mode. Then check Save to 
take effect. 
 
 
 
 
Highlight mask 
ƴ Strong light sources will be masked from the scene, and the image contrast will be strengthened. 

This function is useful to prevent the spot-light effects in a high dynamic scene. 
False color may be observed around the edges of strong light sources. 
Scene mode: image sharpener for motion blur 
When enabled, shutter time will be fixed to 1/120 second to reduce image smear. This feature is designed 
to apply with human movement at the pace of 1.4~2.2m/s. The image sharpener for motion blur 
function is related to Motion detection where motion-alerted pixels need to be suppressed in order to 
increase the accuracy of motion detection. In certain conditions, shadows or light changes can all cause false 
alarms in motion detection. 
The image sharpener for motion blur function uses the same detection window as that of the Motion 
detection. 
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Exposure 
 
On this page, you can set the Exposure measurement window, Exposure level, Exposure mode, Exposure 
time, Gain control, and Day/Night mode settings. You can configure two sets of Exposure settings: one for 
normal situations, the other for special situations, such as the day/night/schedule mode. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Sensor Setting 2: 
For special situations 

 
 
 
 
 
 
Sensor Setting 1: 
For normal situations 

 
 
 
 
 
 
 
 
Exposure strategy: 
Measurement window: This function allows users to set measurement window(s) for low light compensation. 
For example, where low-light objects are posed against an extremely bright background. You may want to 
exclude the bright sunlight shining through a building's corridor. 

ƴ Full view: Calculate the full range of view and offer appropriate light compensation. 

ƴ Custom: This option allows you to manually add customized windows as inclusive or exclusive 
regions. A total of 10 windows can be configured. Please refer to the next page for detailed 
illustration. 

ƴ Auto: Firmware automatically determines an optimal exposure level. 
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¢ƘŜ ƛƴŎƭǳǎƛǾŜ ǿƛƴŘƻǿ ǊŜŦŜǊǎ ǘƻ ǘƘŜ άǿŜƛƎƘǘŜŘ ǿƛƴŘƻǿάΤ ǘƘŜ ŜȄŎƭǳǎƛǾŜ ǿƛƴŘƻǿ ǊŜŦŜǊǎ ǘƻ άƛƎƴƻǊŜŘ ǿƛƴŘƻǿάΦ Lǘ 
adopts the weighted averages method to calculate the value. The inclusive windows have a higher priority. 
You can overlap these windows, and, if you place an exclusive window within a larger inclusive window, the 
exclusive part of the overlapped windows will be deducted from the inclusive window. An exposure value will 
then be calculated out of the remaining of the inclusive window. 
 
 
 
 
 
 
 

Weighted region 

 
 
 
 

Ignored region 

 
 
 
 
 
 
 
 
 
 
 
 
ƴ Center: Use the center portion of the screen to determine the exposure level. 

 
 
 
Metering mode: 

 
ƴ Auto: Lets firmware automatically detect the exposure measurement. 

 
ƴ BLC (Back Light Compensation): This option will automatically add a ñweighted regionñ in the 

middle of the window and give the necessary light compensation. 
 
ƴ  HLC: (Highlight Compensation). Firmware detects strong light sources and compensates on 

affected spots to enhance the overall image quality. For example, the HLC helps reduce the 
glares produced by spotlights or headlights. 

 
 
 

 
 

 
 

 
 

 Include 

 

Exclude  
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Exposure control: 

ƴ  Exposure level: You can manually set the Exposure level, which ranges from -2.0 to +2.0 (dark 
to bright). You can click and drag the semi-circular pointers on the Exposure time and Gain 
control slide bars to specify a range of shutter time and Gain control values within which the 
camera can automatically tune to an optimal imaging result. You may prefer a shorter shutter 
time to better capture moving objects, while a faster shutter reduces light and needs to be 
compensated by electrical brightness gains. 

ƴ Exposure mode: (available when WDR Pro is disabled) 

You can click and drag the semi-circular pointers on the Exposure time and Gain control slide bars to specify 
a range of shutter time and Gain control values within which the camera can automaticallly tune to an 
optimal imaging result. You can also configure the iris size to control the amount of light. For example, you 
may prefer a shorter shutter time to better capture moving objects, while a faster shutter reduces light and 
needs to be compensated by electrical brightness gains. 

ƴ Iris mode: Select Indoor or Outdoor as your application scene. 

 
 
ƴ Flickerless: Under some circumstances when there is a difference between the video capture 

frequency and local AC power frequency (NTSC or PAL), the mismatch causes color shifts or 
flickering images. If the above mismatch occurs, select the Flickerless checkbox, and the range 
of Exposure time (the shutter time) will be limited to a range in order to match the AC power 
frequency. When selected, the exposure time will be forced to stay longer than 1/120 second. 
For cameras that come with fixed iris lens, setting the exposure time to longer than 1/120 second 
may introduce too much lights to the lens. Users can use this option to observe whether the 
result of long exposure time is satisfactory. 

 
 
ƴ AE Speed Adjustment: 

This function applies when you need to monitor fast changing lighting conditions. For example, the camera 
may need to monitor a highway lane or entrance of a parking area at night where cars passing by with their 
lights on can bring fast changes in light levels. The same applies if the camera is installed on a vehicle, and 
when it needs to adapt to fast changes of light when entering and leaving a tunnel. 
 
 
ƴ WDR Pro: 

This refers to the Wide Dynamic Range function that enables the camera to capture details in a high 
contrast environment. Use the checkbox to enable the function, and use the slide bar to select the 
strength of the WDR Pro functionality, depending on the lighting condition at the installation site. You can 
select a higher effect when the contrast is high (between the shaded area and the light behind the objects). 
 
Enable WDR enhanced: This function allows users to identify more image details with an extreme contrast 
from an object of interest with one shadowed side against a bright background, e.g., an entrance. You may 
select the Enable WDR enhanced checkbox, and then adjust the strength (low, medium, high) to reach the 
best image quality. 
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You can click Restore to recall the original settings without incorporating the changes. When completed with 
the settings on this page, click Save to enable the settings. 
If you want to configure another sensor setting for day/night/schedule mode, please click Profile to 
open the Profile of exposure settings page as shown below. 
Activated period: Select the mode this profile to apply to: Day mode, Night mode, or Schedule mode. Please 
manually enter a range of time if you choose Schedule mode. Then check Save to take effect. 
 
Please follow the steps below to set up a profile: 
1. Select the Profile mode tab. 

2.  Select the applicable mode: Night mode or 

Schedule mode. Please manually enter a range of 

time if you choose the Schedule mode. 

3. Configure Exposure control settings in the following 

columns. Please refer to previous discussions for 

detailed information. 

4. Click Save to enable the setting and click Close to 

exit the page. 
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Focus 

Focus here refers to the Remote Focus, applicable to Network Cameras that are equipped 
with a stepping motor lens. The automated focus adjustment function eliminates the needs 
to physically adjust camera focus. In an outdoor deployment consisting of a large number 
of cameras, the auto focus function can be very helpful when these cameras become out 
of focus after days or weeks of operation. And that can easily result from the effects of 
natural forces, e.g., shrink and expand due to a wide range of operating temperatures and 
the vibration caused by wind. 
 

 
 
 
Below is the procedure to perform the automated Focus function: 
 
1. Select from the bottom of the screen whether you want to perform focus adjustment on 

the Full view or within a Custom focus window. You can create a custom window and 

click and drag the window to a desired position on screen. 

 
2. It is recommended to Reset to the default back focus position of the sensor board. 
 
3.  You can use the Fully-opened iris checkbox (default) to increase the iris size for a 

better focus adjustment result. 
 
4. Click to select the Fully-opened iris or the Full-range scan buttons. When a full-range 

scan is selected, a full-range scan through the camera's entire focal length can take 

about 30 to 80 seconds. If not, the auto focus scan will only go through the length where 

optimal focus may occur, and that takes about 15 to 20 seconds. In theory, best results 

of the auto scan can be acquired when the camera's iris is fully open. 
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5. Wait for the scan to complete. After a short while, the clearest image obtained should be 

displayed and the optimal focus range achieved. Use the arrow marks on the sides to fine-tune 

the focus if you are not satisfied with the results. You may still need to use the arrow marks to 

fine-tune the focus depending on the live image on your screen. ñ>ò means moving from wide to 

tele end; and ñ<ò tele to wide. 

 
The methodology of using the Resize Buttons at the upper left corner of the streaming window is the same 
as that on the home page. 
 
Focus window: 

By default, the optimal focus is found on a full view window. You may designate a custom window within 
your current field of view to acquire the best focus out of it. However, you can not place a focus window on a 
distant background, e.g., a hall way that stretches away for 3 meters or farther. Doing so you will not benefit 
from the Focus window function. 

ƴ Full view: The focus tuning takes place by referring to the full view. 

ƴ  Custom: You can create a focus window and drag it to a place of interest in your view window. 
Note that it is recommended to use this function only when you have a solid object in your view 
window that is showing a consistent color or texture. This function will not take effect if you set 
the focus window on a distant background. 
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NOTE: 

 
Privacy mask 

Click Privacy Mask to open the settings page. On this page, you can block out sensitive zones to address 
privacy concerns. 
 

 
 
 
 
ƴ To configure privacy mask windows, 
1. Click New to add a new window. 
2.  You can use 4 mouse clicks to create a new masking window, which is recommended to be at 

least twice the size of the object (height and width) you want to cover. 
3. Enter a Window Name and click Save to enable the setting. 
4. Click on the Enable privacy mask checkbox to enable this function. 

 
 

Ʒ Up to 5 privacy mask windows can be configured on the same screen. 

Ʒ  If you want to delete the privacy mask window, please click the óxô mark on the side of window 
name. 
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Pixel Calculator 

 
Pixel Calculator 

Click the Add button at the lower screen to create a pixel calculator window. Place your cursor on the 
window to move it to an area of your interest, and change the size of window to fit the area of interest. 
 
Once they are drawn, the numbers of pixels on the sides of windows will appear. This allows you to calculate 
if your current configuration fulfills a requirement, for instance, for recognizing the faces of persons passing 
through a location. A facial recognition usually requires around 130 pixels per 
meter or 
higher. 

The pixels thus calculated are listed at the 
lower screen on a per-stream basis depending on 
the frame size you configured for each video stream. 
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Take the following into consideration when using this feature: 

1. Operational requirement: Identify a human or a human face. 

2. Why human face? There are less variances in the size of a face than that for limbs and body. 

Human face is normally 16cm wide. 

3. The recommended pixel number is, 40 to 80 for facial identification; or 100 pixels per foot 

(30.48cm) 

3-1. One example is a human face in retail. 
3-2. Another example is a doorway: 
If the requirement is 100 pixels per foot, to detect a person passing through a door, the camera will have to 
cover 700 pixels throughout the length of a doorway. This application aims to identify a subject passing 
through a specific area. 
 
4. Other factors may include that a person will move in your area of interest: The face may not 

always face the camera. 
5. Details can be affected by weak lighting or the view angle. Therefore, higher the pixels, higher 

the chance you can identify the subject. 
6. The pixel calculator visual tool looks like the following. 
 

With the visual tool, you can estimate a coverage area, the distance from the subject, and place a ruler or an 
object of known size. You can then draw a calculator frame to cover the subject of your interest. 
 
The calculated numbers will be listed at the lower screen. You will then understand if the current 
setting fulfills your requests for the number of pixels. 
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Media > Video 
 
Stream settings 
 

 
 
This Network Camera supports multiple streams with frame sizes ranging from 640 x 320 to 2560 x 1920 
pixels. 
The definition of multiple streams: 
ƴ Stream 1: The default frame size for Stream 1 is set to the 2560 x 1920. 

ƴ Stream 2: The default frame size for Stream 2 is set to the 2560 x 1920. 

ƴ Stream 3: Users can define the "Region of Interest" (viewing region) and the "Output Frame 

Size" (size of the live view window). 

 
Click Viewing Window to open the viewing region settings page. On this page, you can configure the Region 
of Interest and the Output Frame Size for a video stream. For example, you can crop only a portion of the 
image that is of your interest, and thus save the bandwidth needed to transmit the video stream. As the 
picture shown below, the area of your interest in a parking lot should be the vehicles. The blue sky is of little 
value for the surveillance purpose. 
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Media > Video NOTE: 

X2.1 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
1. Select a stream for which you want to set up the viewing region. 
2. Select a Region of Interest  

in the Gloabl View window on the home page, will resize accordingly. If you want to set up 
a customized viewing region, you can also resize and drag the floating frame to a desired 
position with your mouse. 

3. Choose a proper Output Frame Size from the drop-down list according to the size of your 
monitoring device. 

 

Ʒ  All the items in the ñRegion of Interestò should not be larger than the ñOutput Frame 
Sizeñ (current maximum resolution). 

 

ƴ The parameters of the multiple streams: 

 
 Region of Interest Output frame size 

Stream 1 Fixed Fixed 

Stream 2 Fixed Fixed 

Stream 3 1280 x 960 ~ 640 x 320 (Selectable) 1280 x 960 ~ 640 x 320 (Selectable) 

 
 
When completed with the settings in the Viewing Window, click Save to enable the settings and click Close 
to exit the window. The selected Output Frame Size will immediately be applied to the Frame size of each 
video stream. Then you can go back to the home page to test the e-PTZ function.  

 

84 - User's 

FD9387-EHTV-V3 
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Click the stream item to display the detailed information. The maximum frame size will follow your settings 
in the above Viewing Window sections. 
 

 
This Network Camera provides real-time H.265, H.264 and MJPEG compression standards (Triple Codec) for 
real-time viewing. If the H.265 or H.264 mode is selected, the video is streamed via RTSP protocol. There are 
several parameters through which you can adjust the video performance: 
 
 
 
 
 
 
 
 
 
 
 
ƴ Frame size 

You can set up different video resolutions for different viewing devices. For example, you can configure a 
smaller frame size and lower bit rate for remote viewing on mobile phones and a larger video size and a 
higher bit rate for live viewing on web browsers, or recording the stream to an NVR. Note that a larger frame 
size takes up more bandwidth. 

ƴ Maximum frame rate 

This limits the maximum refresh frame rate per second. Set the frame rate higher for smoother 
video quality and for recognizing moving objects in the field of view. 
If the power line frequency is set to 50Hz , the frame rates are selectable at 1fps, 2fps, 3fps, 5fps, 8fps, 10fps, 
12fps, 15fps, and up to 25fps. If the power line frequency is set to 60Hz, the frame rates are selectable at 










































































































































































































































































































































































































































































































































































































































































































































































